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1

Scope

1.1

1.2

1.3

This section identifies the scope, purpose, and organization of this Interface Control
Document (ICD) and identifies the subsystem responsibility list.

Scope and Purpose

This ICD provides the design characteristics of the interface between the Traffic
Flow Management System (TFMS) and the Flight Schedule Monitor (FSM) as it is
implemented for TFMS Build 3. This ICD satisfies the interface design requirements
contained in the Traffic Flow Management System Interface Requirements
Specification (IRS) for Traffic Flow Management Modernization (TFM-M), Release
5 Revision 4.1, dated September 14, 2010. The IRS is a companion document to the
System/Subsystem Specification (SSS) for the Traffic Flow Management—
Modernization (TFM-M), Release 5 Revision 7.1 dated September 14, 2010. This
ICD was prepared under guidance from FAA-STD-025e, dated August 9, 2002 and
the TFMM-ENGR-05(E05), Traffic Flow Management Modernization (TFM-M),
Data Item Description (DID) for ICDs.

The purpose of this ICD is to specify:

o Interface connectivity between TFMS and FSM
o Format of data transmitted between FSM and TFMS

Subsystem Responsibility List

The following list provides the TFMS external system interface and identifies the
responsible Federal Aviation Administration (FAA) organizations:

e TFMS -FAA-ATO-R
e FSM -FAA-ATO-R

Document Organization
This ICD is organized in six sections and one appendix:

Section 1, Scope, describes the purpose and scope of this ICD.

Section 2, Applicable Documents, provides a listing of referenced government and
non-government documents, and document sources researched and used by this ICD.

Section 3, Interface Characteristics, identifies and describes the general
characteristics, functional design, and physical design characteristics for this ICD.

Section 4, Verification Provisions, contains verification provisions for this ICD.

Section 5, Preparation for Delivery, contains any specific preparations required by
this ICD.
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Section 6, Notes, provides a list of definitions, abbreviations, and acronyms used in
this ICD.

Appendix A, FSM — TFMS Tools, provides a description of each of the FSM
commands that result in FSM — TFMS data exchange.

Appendix B, ADL & FSM Broadcast File Format Specifications, provides a
detailed description of the ADL and FSM Broadcast file formats and naming
conventions.

Appendix C, FSM ADL Parameters Specification, provides a detailed description
of the FSM delay program parameters associated with proposed and actual delay
programs. FSM provides these parameters to TFMS and TEMS includes these
parameters, as received, in subsequent ADL file distribution.

Appendix D, CDM Message Protocol, details the application, connectivity and the
protocols used by TFMS to exchange messages via the CDM participant (AOCNet,
FSM, and ARINC) client interface.
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2

Applicable Documents

2.1

The following documents form part of this ICD to the extent specified herein.

Government Documents

FAA Standards:

FAA-STD-025e Preparation of Interface Documentation,
August 9, 2002

FAA-STD-039b Open Systems Architecture and Protocols, May 1, 1996

FAA-STD-043b Open System Interconnect Priority, 1996

FAA-STD-045 OSI Security Architecture, Protocol and Mechanisms,
1994

FAA Orders:

FAA Order 1370.82A Information Systems Security Program, September 11,
2006

FAA Order 1830.2 Telecommunication Standards, Selection and

Implementation Policy, August 1987

National Airspace System (NAS) Documents:

NAS-IR-24032410 Enhanced Traffic Management System (ETMS)
Interface Requirements Document (IRD) for Traffic
Flow Management Infrastructure (TFMI), Revision A,
September 16, 2005

NAS-IR-241400001 Traffic Flow Management System (TFMS) Interface
Requirements Document (IRD) for Traffic Flow
Management Modernization (TFM-M) Version 1.0,
August 14, 2006

Request For Comments (RFC) Documents:

RFC 791 Internet Protocol, Sep 1981
RFC 793 Transmission Control Protocol, Sep 1983
RFC 3076 Canonical XML Version 1.0, Mar 2001

2-1



TFMS-to-FSM Interface Control Document
March 2011 Release 5 FINAL, Revision 1

CSC/TFMM-10/1077
Applicable Documents

2.2

Other Government Documents:

CSC/TFMM-04/0025

CSC/TFMM-11/1247

CSC/TFMM-05/0121

CSC/TFMM-10/1077

FCM-H1-2005

ND319705

TFMM-ENGR-05(E05)

VNTSC-TFM-RM-007

DCN 31F08007-015-R0

Metron Aviation ICD

CSC Memorandum

System/Subsystem Specification (SSS) for the Traffic
Flow Management—Modernization (TFM-M) Program,
Release 5, Revision 7.1, September 14, 2010

Final Information Systems Security Plan (ISSP) - Fiscal
Year (FY) 2011 for Traffic Flow Management—
Modernization (TFM-M), February 28, 2011

Interface Requirements Specification (IRS) for the
Traffic Flow Management — Modernization (TFM-M)
Program, Release 5, Revision 4.1, September 14, 2010

Traffic Flow Management System-to-Airline
Operations Center Network (TFMS-to-AOCNet)
Interface Control Document (ICD), Release 5, Final,
Revision 1, March 1, 2011

Federal Meteorological Handbook No 1: Surface
Weather Observations and Reports, September 1, 2005

Weather Service Operations Manual (WSOM),
Chapter D-31, Aviation Terminal Forecasts, June 6,
1997

Traffic Flow Management Modernization (TFM-M),
Data Item Description (DID), undated

ETMS Reference Manual VVolume I, Version 8.5,
November 2007

ETMS Reference Manual Volume II: FSM User’s
Guide, Version 8.5 Client

FSM/Autosend Server Communications Interface,
Version 1.2, June 28, 2005

Web Coversheet Dictionary FSM 9.0v6,
November 11, 2010

Non-Government Documents

International Organization for Standardization (1ISO):

ISO/IEC 7498-1

Information Processing Systems — Open Systems

2-2
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2.3

231

2.3.2

2.3.3

Interconnect — Basic Reference Model, 1993

Institute of Electrical and Electronics Engineers (IEEE):

IEEE 802.3 IEEE Standard for Information Technology —
Telecommunications and Information Exchange
Between Systems, 2000

American National Standards Institute (ANSI):

ANSI X3.4 American National Standard Code for Information
Interchange (ASCII), Rev. 1992

Document Sources

This subsection provides sources for FAA and International Organization for
Standardization (ISO) documents.

Source of FAA Documents

Copies of FAA specifications, standards, and publications may be obtained from the
Contracting Officer, Federal Aviation Administration, 800 Independence Avenue
S.W., Washington, DC, 20591. Requests should clearly identify the desired material
by number and date and state the intended use of the material.

Request for Comment (RFC) Documents

RFC documents are available from the reference area electronically at the following
Web address:
http://www.fags.org/rfcs/

ISO, IEEE, and ANSI Documents

Copies of ISO, IEEE, and ANSI standards may be obtained from the American
National Standards Institute, 11 West 42nd Street, New York, NY, 10036.
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3

Interface Characteristics

3.1

This section provides the general, functional, and physical interface characteristics
for the TFMS interface with FSM.

General Characteristics

The Flight Schedule Monitor (FSM) was developed for the FAA by Metron
Aviation, providing the FAA, NavCanada, and Collaborative Decision Making
(CDM) participating users with the capability to monitor airport capacity/demand
balance, model traffic flow management initiatives, and evaluate alternative
approaches. FSM provides common situational awareness to FSM users by
presenting airport demand and capacity information with both graphics and text.
FSM contains several rationing schemes that seek to maintain an efficient and
equitable balance between capacity and demand. FSM is also used by the Air Traffic
Control System Command Center (ATCSCC) to implement Ground Stop (GS) and
Ground Delay Program (GDP) strategies. Airline Operations Centers use FSM to
assess the proposed GS/GDP, develop strategies to cope with the restrictions, and
monitor GS/GDP initiatives that are in effect. FSM is used by more than 30 FAA
facilities, 40 airlines, and an increasing General Aviation community in the United
States and Canada.

The TFMS-to-FSM interface described in this ICD is from the FSM Server to the
TFEMS TPC.

Figure 3-1, TFMS-to-FSM Interface Block Diagram, illustrates the TFMS-to-FSM
interface and the demarcation point for the FSM to TPC. The demarcation point is
illustrated as a black dot.
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TFMS-to-FSM Interface Block Diagram
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Figure 3-1. TFMS-to-FSM Interface Block Diagram
The TFMS-to-FSM interface transfers data via three communications paths
(depending on the FSM Server entity interfacing), as detailed below:

e Viathe FAA FTI Ops-IP Gateway — This pathway enables data transfers via a
closed “trusted’ high speed connection system (primarily at the ATCSCC). This

3-2
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3.2

3.2.1

3.2.1.1

allows communications to and from FSM Servers, through the Ops-IP Gateway
into a designated TFMS router and then through the FAA Portal Subsystem for
further processing. The interface uses the standard TCP/IP protocols for
communications. The demarcation point is at the TFMS router.

Via the National Airspace System (NAS) Security Gateway (NESG) — This
pathway enables data transfers via the NESG communication system. NESG is a
closed “untrusted’ high speed connection system, allowing a communications link
to specified an External TRS (ETRS) and other designated systems. The External
TRSs connect to the NESG via the VPN/Internet. The Canadian traffic flows into
the NESG via a dedicated circuit. This allows communications to and from FSM
Servers, through the NESG Gateway, into a designated TFMS router and switch,
and then into the External Portal Subsystem for further processing. The interface
uses the standard TCP/IP protocols for communications. The demarcation point is
at the TFMS switch.

Via the AOCNET/CDM Wide Area Network — This pathway enables data
transfers to the FSM Servers via the AOCNET/CDM WAN. The AOCNet/CDM
WAN is an open ‘untrusted’ system used by airlines and other entities for FSM
communications. This allows communications from the FSM Servers to
communicate through the AOCNET/CDM WAN (maintained by Aeronautical
Radio INC) into the NESG over to the designated TFMS router and switch, and
then to the External Portal Subsystem for further processing. The interface uses
the standard TCP/IP protocols for communications. The demarcation point is at
the TFMS switch.

Refer to Section 3.3 for a detailed physical detailing of the TFMS-to-FSM Interface.

Functional Design Characteristics

This subsection describes the functional design characteristics of the TFMS and
FSM.

Application Processes (APs)

This subsection identifies each application process and the applicable services,
including performance characteristics (information units, quality of service, error
handling, and responses).

Identification of Application Processes
The TFMS uses the following APs to send and receive data from FSM:

FT1 Ops-IP WAN — This interface AP is the FAA Portal Message Interface
Server located in the FAA Portal Subsystem

VPN/Internet via NESG — This interface AP is the External Portal Message
Interface Server located in the External Portal Subsystem

AOCNET/CDM WAN - This interface AP is also the External Portal Message
Interface Server located in the External Portal Subsystem
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The corresponding FSM AP is the FSM Server AP.

3.2.1.2 Category of Services Required by the AP

Loss of the TFMS-to-FSM interface will impair full system operation, but will not
degrade TFMS operations to the point of inoperability. This interface is designated
“essential” AW NAS-SR-1000.

3.2.1.2.1 Application Services ldentification
The TFMS-to-FSM interface is used to transfer the following data from FSM:

Aggregate Demand List Requests

FSM Broadcast Request

Substitution Messages

EDCT Control Commands and Report Requests
Delay Program Rates

Delay Program Parameters

Heartbeat Message

The TFMS-to-FSM interface is used to transfer the following data to FSM:

Aggregate Demand List

FSM Broadcast Response

FSM Broadcast Message

Substitution Message Responses

EDCT Control Command Responses and Reports
Heartbeat Acknowledgements

3.2.1.3 Information Units

This subsection describes the formats of the data transferred between FSM and
TEMS.

3.2.1.3.1 Information Code

All TFMS-to-FSM interface messages are encoded in American Standard Code for
Information Interchange (ASCII) alphanumeric data format in accordance with ANSI
X3.4, American National Standard Code for Information Interchange (ASCII), Rev.
1992., as described in Section 3.2.1.3.2, and the appropriate subsections.

In addition, the FSM Broadcast Message and one element of the Aggregate Demand
List (ADL) are encoded in XML, an ASClI-based encoding format (conforming to
the documentation in the previous paragraph), in accordance with RFC 3076,
Canonical XML Version 1.0, Mar 2001.

3.2.1.3.2 Information Structure

The following subsections provide the detailed record layout of the products sent by
the FSM. Table 3-1, TFMS-to-FSM Interface Messages Table, presents the TFMS-

3-4
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to-FSM Interface Messages, including the subsection reference and mnemonic.

Table 3-1. TFMS-to-FSM Interface Messages

Product :
Product Name . ICD Subsection
Mnemonic
Aggregate Demand List ADL 321321
FSM Broadcast Request 321322
FSM Broadcast Reply 3.2.13.23
FSM Broadcast Message FBCM 321324
Slot Credit Substitution Message SCS 3.2.13.25
Substitution Good Responses N/A 3.21.3.2.6
Substitution Error Responses N/A 3.2.1.3.27
EDCT and Other Commands N/A 3.2.1.3.28
EDCT List EDCT List 3.2.1.3.29
EDCT Sub Show EDCT Sub Show 3.2.1.3.2.10
EDCT SList EDCT SList 3.2.13.211
EDCT Unassigned Slots EDCT Unassigned 3.2.1.3.2.12
Slots
Delay Program Rate Messages AAR or ADR 3.2.1.3.2.13
Delay Program Parameters Messages GDP (or GS or AFP) 3.2.13.214
PARAM, COMP
PARAM, or BLANK
PARAM
Heartbeat Message HB 3.2.1.3.2.15

The following syntax rules are used for field specifiers in the ASCII Tables
following the following subsections. Below these rules are the conventions for XML
entries.

o L —represents one upper-case letter in ASCII

e d - represents one numeric digits in ASCII

e n—represents one integer in ASCII

e a-—represents one alphanumeric (either number or upper-case letter) in ASCII

e [] — means the characters enclosed are optional. Any characters not within
brackets are required. For example, Ldd [aa] would indicate an upper-case letter,
followed by two digits, and then zero, one, or two optional alphanumeric
characters.

« BOLD indicates a static entry.

e ITALIC entries are optional to the message
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o All times, unless specified will be in DayDayhourhourminuteminute (DDhhmm)

format

The following rules apply to the XML schema:

o The files contain only printable ASCII characters.
e The file format follows standard XML structural conventions.
e In XML terminology, the files are guaranteed to be:

©)

o

Valid — The XML file content matches the proper schema and
documentation.

"Well-Formed.” - This means that every opening tag (i.e. - <TAG>) has a
corresponding closing tag (i.e. - </TAG>), opening and closing tag pairs
are correctly matched and nested, and consistent capitalization is used.
Note - The first line of every file is the standard "<?xML .. .>" entry,
identifying the XML version number. This is the only tag which has no
corresponding close tag.

Simple - Only a simple subset of XML is used. All data is between
matching start and end tags:

<TAG>data</TAG>

The files do not contain data in any other XML form. For example,
composite tags (e.g., <TAG="data”/>) and attributes are never used. Note
- New-line characters between matching start and end tags are part of the
element's data.

Structured — The XML file consists of data element (or simply an
element), consisting of a pair of matching start and end tags, together with
the data between them. Elements can contain other elements, and are
referred to as a container. The container element is considered to be the
‘parent’ to the elements contained within. Elements contained within the
‘parent’ container are considered ‘child’ elements. Example:

<CTR_ROUTE>
<CTR_SEG>...</CTR_SEG>
</CTR_ROUTE>

Only a simple subset of XML is used. All data is between matching start
and end tags:
<TAG>data</TAG>

Characters that are not between matching start and end tags are ignored.
They are and may be used occasionally for comments or enhancements of
clarity. Example:
<TAG1>
<TAG2>This is data </TAG2>
This is a comment.
<TAG2>This is data</TAG2>
</TAG1>
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Data elements can be in any order within their container element's tag pair
(if element is a child of a parent element) or within the file (if an element
not acting as a container).

3.2.1.3.2.1 Aggregate Demand List

The ADL is the primary product that drives FSM and is used by many AOCNET
Participants. It is an ASCII file consisting of two distinct parts, the header and the
data update sections. It is comprised of data extracted from the TFMS databases,

which are maintained with a combination of:

o Official Airline Guide (OAG) data

« Airline-provided flight data messages (FC, FX, FM, El, and OOOI data)

o NAS messages generated from the ATC system (FZ, DZ, RZ, AZ, AF, UZ, and
TZ data messages)

e lIssued ground delays (EDCTs — CTs for individual delays, FA for blanket
delays)

o GDP-specific data entered by traffic management specialists using AOCNET.

Refer to Appendix B ADL & FSM Broadcast File Format Specifications for a
detailed description of the ADL file format.

3.2.1.3.2.2 FSM Broadcast Request

A client application, (in this case, FSM) requests that an FSM Broadcast message be
sent from the TFMS. The format of the request is completely contained within a
CDM Protocol message and no explicit application message is sent by the client.
Refer to the M_AUTO_MONITOR_REQ protocol message (located in Appendix D)
for details.

3.2.1.3.2.3 FSM Broadcast Reply

The FSM Broadcast Reply Message is sent by the TFMS as a reply to a FSM
Broadcast Request Message from a client application (typically FSM). The format
of the message is identical to the format of the FSM Broadcast Message. Refer to
the M_AUTO_MONITOR_REPLY protocol message (located in Appendix D) and
Section 3.2.1.3.2.4 (FSM Broadcast Message) for details.

3.2.1.3.2.4 FSM Broadcast Message

TFMS sends an FSM Broadcast Message (separate from ADLS) to notify
applications, primarily FSM, of two sets of dynamic data:

e The current traffic management initiatives that are proposed, in place, or have
been purged on this day,
e The current FEAs and FCAs that are available for monitoring with FSM.

Refer to Appendix B, ADL & FSM Broadcast File Format Specifications, for a
detailed description of the FSM Broadcast Message format.
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3.2.1.3.2.

5 Slot Credit Substitution Message (SCS)

A slot credit substitution request can be submitted to TFMS using the SCS message.
The format of the SCS message differs from the other CDM messages in that the
format is completely fixed. Special fields are used in the SCS that cannot be
modified by the CDM Flight Modify (FM) message (see TFMS-to-AOCnet Interface
Control Document). This was done because the additional fields in an SCS message
are not flight attributes that are stored by TFMS. Rather, they are temporary values
used only in the processing of the request.

An SCS message uses the fields specified in Table 3-11, in the indicated order.

Table 3-II. Slot Credit Substitution (SCS) Message

Field

Designation Unit/Format Description Bytes

Field 01

Message type SCS Static Entry - SCS 3

Field 02

Flight Identification La[a][a][a][a] | Flight call sign (Flight ID) as it 2-7
[a] appears in the OAG and/or
subsequently will be filed on the
NAS flight plan. Only the
aircraft identification portion of
the NAS syntax is accepted (i.e.,
the computer IDs are not used
here). Flight IDs must match the
NAS flight plan exactly. IDs
consisting of a 3-letter code and
a flight number should use
leading zeros on the flight
number only if they will be filed
that way on the flight plan.

Field 26

Departure Airport aaa[a] ICAOQ identifier for the airport 3-4
(NAS Departure of origin for this flight leg.
Point) TFMS also accepts published
FAA 3-letter designator for
CONUS airports.

Field 27

Arrival Airport aaa[a] ICAO identifier for the 3-4
destination airport for this flight
leg. TFMS also accepts
published FAA three-letter
designator for CONUS airports.
Called Destination in NAS.

Example - JFK, KJFK, 32G

Field A1

UTC Departure dddddddd Date/time on which the flight 8
Date/Time leg was originally scheduled to
depart the gate. Format is
MMDDhhmm, and must be 8
digits, zero padded.

This field is used as part of the
unique identification of a flight
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Field Designation Unit/Format Description Bytes
leg.
Example - 06261225
No tag Yielded Slot Laadddddda | Slot designator. The format is a | 10-14
Or concatenation of:
FCAaaadddddd | ® Airport name: 3 or 4
a characters or FCA name :
FCA followed by up to 3
characters

e S|ot date and time: Format is
DDhhmm, and must be
6digits, zero padded.

e 1-letter suffix: The suffix
letter is used to ensure that
slot name is unique

No tag Earliest Acceptable dddddd Earliest acceptable time the 6
Time aircraft will take. Format is
DDhhmm, and must be 6 digits,
zero padded.

No tag Latest Acceptable dddddd Latest acceptable time the 6
Time aircraft will take. Format is
DDhhmm, and must be 6 digits,
zero padded.

Sample Slot Credit Substitution (SCS) Message for a GDP

SCS UNA1277 DFW SFO 03241701 SFO.242040A 242050 242120

Sample Slot Credit Substitution (SCS) Message for an AFP

SCS UNA1277 DFW SFO 03241701 FCAA02.242040A 242050 242120

The fields contained in the above examples have the following meaning:

e SCs —This is an SCS request message type. (Required)

e UNA1277 —The ID of the flight to be subbed into the new slot. (Required)
e DFW — The origin of the flight. (Required)

e SFO — The destination of the flight. (Required)

e 03241701 — The original departure date/time for the flight. (Required)

e SFO0.242040A — The yielded slot. (Required)

e 242050 — The earliest acceptable time for the new slot. (Required)

e 242120 — The latest acceptable time for the new slot. (Required)
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In addition, there are other notes that provide guidance on ECR messages:

o The SCS message is allowed only in an SS packet. The SS packet
M_SS Data Packet [112] is described in detail in Appendix D. The only
message FSM sends in an SS packet is the SCS message.

3.2.1.3.2.6 Substitution Good Responses

The FAA will send a response to every SS message packet. The response is sent to
the return address on the incoming message. The format of the response is the same
regardless of what types of messages were sent in the SS packet.

If no errors are detected in the SS packet, the FAA database is updated to reflect the
changes requested by the airlines. The response to the airline includes the packet
identifier, a message indicating it was successfully processed, and an updated slot list
for each flight affected by the message.

Sample Substitution Good Response
(Line Numbers for Reference Only)

(1) ss ABC0625121029.01 ACCEPTED.

(2) SLOT LIST for LGA

(3)

(4) ACID ASLOT DEP ARR CTD CTA TYPE EX CX SH ERTA IGTD
(5) ABC1234 LGA260500A DCA LGA 260400 260500 ECR - Y - - 260145
(6) ABC5678 LGA260400A IAD LGA 260300 260400 SBRG - - - 260400 260245

Table 3-111 below presents a breakout of the Substitution Good Response

Table 3-Ill. Substitution Good Response Message

Field Designation Unit/Format Description Bytes
Packet Type | Initial Packet Type LL Identifies the initial packet type 3
Identifier being replied to
Sender Sender ID code aaa 3-character code of the data 3

sender (An airline with an FAA-
assigned 3-letter code will use
that code in the packet header;
e.g., AAL, FDX. A data
provider that is sending data for
N-number flights will use the 3-
letter code assigned by FAA
especially for this purpose.)

DTG Date /Time Group dddddddddd | 10-digit transmission date and 10
time in the format:
MMDDhhmmss

Period Separator period . One period, separating the DTG 1

from the Unique ID.
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Departure

e CTA —Controlled Time of
Arrival

e TYPE - Type of Entry

e EX - Exempt Flag (Yes or
No)

e CX-—Control Flag (Yes or
No)

e SH-Slot Hold flag (Yes or
No)

e EENTRY - Earliest Entry
Time (for AFP)
or ERTA - Earliest Runway
Time of Arrival (for Airport
GDP)

e |GTD - Initial Gate Time of
Departure

Field Designation Unit/Format Description Bytes
Unique Unique identifier dd 2 digits for uniqueness (in case 2
multiple messages are generated
in the same second)
Space Space [1 One space separating the Unique 1
code from the Processed entry
Accepted Accepted ACCEPTED | Shows the identifier of the 8
packet that is being replied to.
The word “ACCEPTED”
indicates that the processing of
the packet was successful.
Data ID Data Identifier ATCSCC Static Entry - ATCSCC EDCT 39
EDCT FLOW | FLOW CONTROL
CONTROL | DEPARTURE TIME
DEPARTURE
TIME
Headers Slot List Data ACID Header for the following data 64
Headers ASLOT fields:
DEP ARR | e ACID — Aircraft identifier
CTD CTA .
TYPEEX CX | ® ASLOT — Arrival S_Iot
SH EENTRY L] DEP — Departure AlrpOI‘t
(or) ERTA e ARR - Arrival Airport
IGTD e CTD - Controlled Time of
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Field

Designation

Unit/Format

Description

Bytes

SLOT LisT DATA FIELDS*

ACID

Flight Identification

Laa[a][a][a][a]

Flight call sign as it appears in
the OAG and/or subsequently
will be filed on the NAS flight
plan. Padded with spaces to
equal 8 bytes.

ASLOT

Arrival Slot

LLL[Laa].dddd
ddL
or
FCAaaa.ddddd
dL

The time slot reserved at the
airport or FCA for this flight to
arrive as follows:

e Name —airport or FCA
name. An airport name can
be three or four characters
and can include letters and
numbers. An FCA name
must be the entry FCA
followed by three
alphanumeric characters.
The name is separated from
the Date/Time by a period
for readability

e Date/Time — Slot date and
time. The format is
DDhhmm (padded as
necessary)

e Suffix Letter - The suffix
letter is used to ensure that
slot name is unique.

Note - An FCA name must be

six characters starting with the

literal letters “FCA”. The
remaining characters can be
either digits, upper-case letters,

dash (“-*), or underscore (“ 7).

An FCA name cannot end with

an underscore. Padded with

spaces to equal 15 bytes.

15

DEP

Departure Airport

LLL[L]

Departure airport code in
standard 3 or 4 letter identifier,
padded with spaces to equal 5
bytes
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Field

Designation

Unit/Format

Description

Bytes

ARR

Arrival Airport

LLL[L]

Arrival airport code in standard
3 or 4 letter identifier, padded
with spaces to equal 5 bytes.
Note - For a GDP, the arrival
airport will be the same for
every flight; for an AFP, they
may differ. It is padded with
spaces to equal 5 bytes

5

CTD

Controlled Time of
Departure

dddddd

The time the flight should take
off In the format DDhhmm,
padded with spaces to equal 7
bytes

CTA

Controlled Time of
Arrival

dddddd

The time the flight should arrive
at the controlled airport or FCA
(e.g., 260400). In the format
DDhhmm, padded with spaces
to equal 7 bytes

TYPE

Control Type

LLL[L]

The source of the current control
times for this flight (e.g. GDP).
The control types that can
appear in a slot list are:

e ABRG - Control times were
assigned when the flight was
utilized to create a bridge in
order to adaptive compress a
slot.

e ADPT — Control time
assigned when the flight was
adaptively compressed by
the TFMS adaptive
compression process (AFP
and GDP)

e AFP — Control times were
computed as part of an
initial AFP, a revision to an
AFP, or an extension to an
AFP.

e BLKT — Control times were
computed by a blanket
program.

e COMP — Control times were
computed by compression.

e DAS — Control time which
resulted from the
assignment of the average
delay to a pop-up flight
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Field Designation Unit/Format Description Bytes

which did not receive an
unassigned slot in an AFP or
GDP. For DAS based
programs this is used for the
initial delay assignments to
all pop-up flights. For
GAAP and UDP based
program, this control type is
used only if no unassigned
slot is available for the pop-
up. This control type is not
used for re-controlled
flights. (AFP and GDP)

e ECR - Control times were
assigned by an FAA ECR
request.

e GAAP — Control times are
the result of a GAAP or
UDP based AFP or GDP if a
pop-up or a re-control flight
is allocated to an unassigned
slot. This occurs for all pop-
up flights in a GAAP or
UDP based program when
an unassigned slot is
available for the flight
However, only some classes
of re-controlled flights in a
GAAP or UDP are assigned
to unassigned slots. (e.g.,
those that occur after
dropping out of an AFP).
(AFP and GDP)

e GDP — Control times were
computed as part of an
initial GDP, a revision to a
GDP, or an extension to a
GDP.

e GS - Control times were
computed by a ground stop.

e RCTL — Control time which
resulted from the
assignment of the average
delay to a flight that was at
some point controlled by a
GDP or AFP, which was
then purged or the flight
dropped out and was re-
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Field Designation Unit/Format Description Bytes

controlled in another AFP.
For DAS programs this is
used for the initial delay
assignments to all re-
controlled flights. For
GAAP and UDP, this
control type is used only if
no unassigned slot is
available for the re-
controlled flight or the class
of re-controlled flight is
never assigned to
unassigned slots. As
opposed to other pop-ups,
RCTL flights retain full
substitution rights (AFP)

e SBRG - Control times were
assigned when creating a
bridge for an SCS or ECR
request.

e SCS — Control times were
assigned by a user slot credit
substitution message.

e SUB - Control times were
assigned by a conventional
user substitution message.

e UBRG - Control times were
assigned when creating a
bridge for pop-up flight
assignment during UDP.
Performed automatically by
the TFMS Core (AFP and
GDP)

e UPD - Control times are
from an FAA “EDCT
UPDATE” command.

This entry is padded with spaces
to equal 5 bytes.
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EX Exempt Flag Y Flag indicating flight was 3
or exempt from delays when the

GDP or AFP was computed.
(one of two entries):

e Y iftrue
o -if False

This entry is padded with spaces
to equal 3 bytes

CX Cancel Flag Y Flag indicating whether the 3
or flight is currently cancelled.
_ (one of two entries):
e Y iftrue
o -if False

This entry is padded with spaces
to equal 3 bytes

SH Slot Hold Flag Y Flag indicating whether the 3
or flight is currently on Slot Hold.
_ (one of two entries):
o Y iftrue
o -ifFalse

This entry is padded with spaces
to equal 3 bytes
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ERTAfora | Earliest Runway dddddd The earliest time flight can 6
GDP Time of Arrival arrive at the controlled element
or in the case that the delays are
EENTRY for . . reduced (e.g., 260200). In the
an AP Earliest Entry Time format DDhhmm, padded with

spaces to equal 7 bytes

EENTRY is used to ensure that
a flight will not be assigned a
slot for an AFP that it cannot
use. Since the CDM Participants
do not send earliest entry times
for an FCA, TFMS computes
this by: first determining the
earliest ETA (EETA), then
applying any delta to the
ENTRY time.

e If flight has ERTD,
EENTRY = ENTRY +
(ERTD-ETD)

e Else if flight has LRTD,
EENTRY = ENTRY +
(LRTD-ETD)

e Else if flight has LGTD,
EENTRY = ENTRY +
((LGTD+10)-ETD)

e Else if flight has IGTD,
EENTRY = ENTRY +
((IGTD+10)-ETD)

Else, EENTRY = ENTRY

IGTD Initial Gate Time of dddddd The original scheduled gate 6
Departure push back time for the flight in
the format DDhhmm. Used to
uniquely identify the flight.

*Note — There may be multiple rows of data under the header.

3.2.1.3.2.7 Substitution Error Responses

If errors are detected in the SS packet, the entire packet is rejected and the FAA
database is not updated. The response includes the packet identifier, a message
indicating it was rejected, and the number of errors. For each error, the response
shows the SS message that triggered the error and the reason for the error. (For a
complete listing of Error messages, refer to Table 3-1V.)
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Sample Error Response
(Line Numbers for Reference Only)

(1) SS ABC0625121029.01 REJECTED. 1 ERROR.
(2)
(3) SCS UNA1277 DFW SFO 03241701 FCAA02.242040A 242050 242140
(4) ERR417: CTA NOT WITHIN 20-MINUTE WINDOW
The meaning of the sample response is as follows:
Line 1: Shows the identifier of the packet that is being replied to. The word
“REJECTED” indicates that the processing of the packet was successful. The number
of errors is shown.
Line 2: blank
Line 3: The SS message that triggered the error.
Line 4: The error code and message. In this case, it was Error 417, indicating the
flight specified on an ECR message could not be updated in the TFMS database, due
to the fact that the CTA was not within the 20-minute window for slot times.
Table 3-IV. Error Code Messages
Number Error Description Corrective Action
Packet Header Error Messages
ERR401 PACKET NOT PROCESSED The packet has not been processed due to internal
TFMS error.
ERR402 PACKET ID IS MISSING. USE The packet header line does not include a packet
LLLDDDDDDDDDD.DD ID.
ERR403 INVALID PACKET ID. USE The packet ID does not match the specified
LLLDDDDDDDDDD.DD syntax.
ERR405 UNKNOWN PACKET CODE. USE FD | The packet contains a code other than FD in the
OR SS header line.
ERR406 PACKET CODE LINE MISSING. USE The packet has no header line.
FD LLLDDDDDDDDDD.DD
ERR407 UNKNOWN HUB SITE ARINC The packet was sent to the wrong address.
ADDRESS. USE QU BOSCDYA
ERR408 PACKET NOT PROCESSED An error occurred while attempting to update the
TFMS Flight Database (FDB).
ERR409 MESSAGE NOT PROCESSED DUE TO | An error occurred while attempting to update the
TFMS INTERNAL ERROR TFMS Flight Database (FDB).
ERR410 INVALID EN ROUTE TIME En Route Time may not exceed 18 hours.
ERR411 MESSAGE NOT PROCESSED: FDB IN | This message should only appear on internal
SLAVE MODE. TFMS logs.
Slot Credit Substitution Error Messages
ERR412 ILLEGAL HOLD FLAG VALUE: USE Valid values for Hold Flag are H to hold slot or R
RORH to release slot.
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Number Error Description Corrective Action
ERR414 NOT AUTHORIZED TO SUB FOR At least one flight in this packet belongs to a
THESE FLIGHTS carrier for which the sender is not authorized to
make substitutions at this airport. Sender must be
authorized to submit substitutions for all flights
referenced in an SS packet.

ERR415 CANNOT CANCEL A NON- An FX message submitted in an SS packet must

CONTROLLED FLIGHT pertain to a controlled flight. A non-controlled
flight may only be cancelled in an FD packet.
The most common cause for this error is an
incorrect flight ID, origin, destination, or original
gate departure date and time.

ERRA417 CTA NOT WITHIN 20-MINUTE CTA must be no earlier than the slot time for the

WINDOW flight’s assigned slot, and no more than 20
minutes later than the slot time.

ERR418 CANNOT SUB INTO SLOT NOT The FM message references a slot that does not

OWNED BY THIS CARRIER currently belong to the sending airline or one of
its authorized affiliates.

ERR419 CANNOT SUB TWO FLIGHTS IN ONE | Packet contains FM messages that assign more

SLOT than one flight to the same slot. Only one flight
may be assigned to a slot.

ERR420 CANNOT SUB ONE FLIGHT IN TWO | Packet contains FM messages that assign a flight

SLOTS to more than one slot. A flight may be assigned to
only one slot.

ERR421 CANNOT SUB A NON-CONTROLLED | Cannot use an FM message to assign a flight to a

FLIGHT slot if the flight does not already have a slot
assignment. This message is generated if the
flight referenced in an FM does not exist in the
TFMS flight database, or if it exists but is not
currently controlled. The most common cause is
an incorrect flight 1D, origin, destination, or
original gate departure date and time.

ERR422 CANNOT CONTROL FLIGHT An SC message can be used to create a slot and

SCHEDULED TO ARRIVE DURING assign it to a flight only if the flight is scheduled

GDP to arrive after the GDP end time is over.

ERR423 SLOT NOT OWNED BY FLIGHT IN In order to preserve the one-flight-one-slot rule,

THIS PACKET every slot that is assigned in an SS packet must
be assigned to another flight in that packet prior
to the packet being processed.

ERR424 CANNOT SUB INTO SLOT Flight cannot be assigned to an earlier slot if the

OCCUPIED BY FORMER POP-UP flight currently assigned to that slot was formerly

FLIGHT a pop-up.

ERR425 AIRPORT NOT CONTROLLED A HOLD ALL SLOTS or RELEASE ALL
SLOTS message was received for an airport that
does not currently have a GDP.

ERR426 CANNOT CHANGE HOLD FLAG FOR | Cannot modify hold flag for flight that does not

NON-CANCELLED FLIGHT have an assigned slot in a GDP. The most
common cause for this error is an incorrect flight
ID, origin, destination, or original gate departure
date and time.
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Number Error Description Corrective Action
ERR427 CANNOT SUB POP-UP FLIGHT Cannot assign a pop-up flight to a slot. Only a
revision may assign a pop-up to a slot, after
which the flight is referred to as a former pop-up.

ERR428 CONTROL INFO MISSING. SPECIFY: | CTD, CTA, and ASLOT fields are required in an
DEP.TIME, ARR.TIME, AND SLOT FM message submitted in an SS packet.

ERR429 SLOT TIME CANNOT BE IN THE A flight cannot be assigned to a slot whose slot
PAST time is earlier than the current time.

ERR430 CANNOT SUB COMPLETED FLIGHT | Cannot modify slot assignment for a completed

flight.

ERR431 CANNOT SUB MULTIPLE AIRPORTS | All messages in an SS packet must pertain to

flights arriving at the same airport.

ERR432 CANNOT SEND FC MESSAGE IN SS Flights cannot be created in an SS packet. An FC
PACKET message may only be submitted in an FD packet.

ERR433 SC CAN BE SENT ONLY IN SS Slots cannot be created in an FD packet. An SC
PACKET message may only be submitted in an SS packet.

ERR434 CANNOT CREATE SLOT FOR Flight referenced in SC message is already
CONTROLLED FLIGHT controlled. Cannot use SC message to create a

slot and assign a flight to the newly created slot if
the flight already has an assigned slot or an FA
Delay.

ERR435 SLOT ALREADY EXISTS The slot value provided in SC message already
exists. A newly created slot must have a unique
slot identifier. An airline can generally create a
unique identifier by changing the suffix letter in
the slot name.

ERR436 INVALID MESSAGE TYPE FOR SS Only FM, FX, SCS, HOLD ALL SLOTS or
PACKET. USE FM/FX/SCS/HOLD ALL | RELEASE ALL SLOTS are valid within an SS
SLOTS/RELEASE ALL SLOTS packet.

ERR437 SLOT IN SC MSG CANNOT BE Slot time for newly created slot falls in the
DURING CURRENT GDP current GDP timeframe. For an airline to create a

slot, the slot time portion of the “Assigned
Arrival Slot” field in the SC message must
specify a time that is after the GDP is over.

ERR438 CANNOT SUB REMOVED FLIGHT The flight has been removed by the FAA and is

not available for subbing.

ERR439 ETE CANNOT BE CHANGED BY The new ETE, derived by subtracting CTD from
MORE THAN 50% CTA, cannot change from the prior ETE by more

than 45 minutes or 50% of the prior ETE,
whichever is greater.

ERR440 SUB PROCESSING IS OFF Command Center is currently not accepting

substitution messages pertaining to this GDP.
TFMS sends an TFMS SUBS ON message when
it resumes accepting substitution messages

ERR441 SCS CAN ONLY BE INCLUDED IN SS | A Slot Credit Sub message can only be included
PACKETS in an SS packet, not in an FD or EI packet.
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Number Error Description Corrective Action

ERR442 SCS PROCESSING IS OFF The FAA has turned Slot Credit Sub processing
off for the airport. All SCS requests will be
rejected.

ERR443 YIELDED SLOT MUST BE IN THE The slot that is being given up in the SCS

FUTURE message must be later than the current time.

ERR444 EARLIEST ACCEPTABLE TIME The time of the yielded slot must be earlier than

MUST BE LATER THAN TIME OF the earliest acceptable time.
YIELDED SLOT
ERR445 EARLIEST ACCEPTABLE TIME The window of acceptable times must be
MUST BE EARLIER THAN LATEST specified as the earliest acceptable time first then
ACCEPTABLE TIME the latest acceptable time.
ERR446 20-MINUTE WINDOW NOT The substitution window size for an SCS packet
ALLOWED WITH SCS must be set to 0. If any flights within the packet
violate the window size, then the packet will be
rejected.
ERR447 YIELDED SLOT OWNED BY The yielded slot must not be owned by a former
FORMER POP-UP FLIGHT pop-up.

ERR448 SCS TIME RANGES OVERLAP The time ranges of different SCS messages
within a packet must not overlap. The time range
of an SCS is defined as the time from the yielded
slot to the latest acceptable time.

ERR449 SLOT CREDIT SUBSTITUTION No bridge flights could be found that would

CANNOT BE FULFILLED allow the SCS flight to be moved into the
requested window.

ERR450 SLOT TIME OF SCS FLIGHT IS The yielded slot of the SCS flight already falls

ALREADY WITHIN WINDOW within the requested window. No processing is
required.

ERR451 SCS PROCESSING HAS BEEN The FAA has suspended SCS processing

DISABLED UNTIL FURTHER NOTICE | temporarily.

3.2.1.3.2.8 EDCT and Other Commands

In general, EDCT commands are associated with the management of delay programs.
There are two basic categories of commands, commands that request data (i.e,
reports) and commands that change data. Most of the EDCT commands can be
entered from both the TFMS TSD and the FSM client. Also, most of these
commands are only available to FAA authorized users. This ICD documents those
EDCT commands entered via FSM, which result in a data exchange between FSM
and TFMS. The format of the command entered by a user is the same regardless of
whether it is entered from a TSD or FSM. However, when an EDCT command is
entered from FSM, the command is sent to the TFMS, where the data associated with
the command can be changed (with the change acknowledged) or provided back to
the requestor in the form of a report. The available EDCT commands related to FSM
are as follows:
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e EDCT AC OFF e EDCT SCSON
e EDCT ACON e EDCT SHOW
e EDCT CHECK e EDCT SLIST (report request)
e EDCT CNX e EDCT SLOTS
e EDCT CTALIST e EDCT SUB OFF
e EDCTHOLD e EDCT SUB ON
e EDCT LIST (report request) e EDCT
e EDCT LOG e EDCT SUB SHOW (report
request)

e EDCT PURGE

e EDCT RELEASE
e EDCT REMOVE
e EDCT RESTORE
e EDCT SCS OFF

e EDCT UNASSIGNED SLOTS
(report request)

e EDCT UPDATE

These commands are documented in the ETMS Reference Manual VVolumes | and 11
(refer to Section 2.1) for full references. The commands are also briefly described in
Appendix A of this ICD. The mechanisms used to send these commands and their
corresponding replies between TFMS and FSM are the protocol messages, which are
documented in Section 3.2.2.1, Application Services.

The following additional commands are available to the FSM user, which result in a
data exchange on the TFMS — FSM interface:

e Weather Request — used to request current airport weather (METAR and TAF)
for one or more airports (uses the three letter airport identifiers separated by
commas or spaces)

e ADL Request — used to request a new ADL for a specific airport or FSM-eligible
FEA/FSM.

e ADL AAR - used to reset an Arrival Rate to its default or to modify ADL
Arrival Rates for an airport or FSM eligible FEA/FCAADL

e ADR - used to reset a Departure Rate to its default or to modify ADL Departure
Rates for an airport

e Delete Program Parameters — used to delete delay program parameters for a
specific airport or Flow Constrained Area (FCA).

These commands are documented in the ETMS Reference Manual Vol. 1 (refer to
Section 2.1) for full reference. The commands are also briefly described in Appendix
A of this ICD. The mechanisms used to send these commands and their
corresponding replies between TFMS and FSM are the protocol messages, which are
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documented in Appendix D, CDM Message Protocol.

NAS Users can make requests for data as well as requests that control aspects of
substitution process. Four reports are available to the NAS Users. These reports
apply to FCAs, AFPs as well as airports GDPs:

EDCT Report Requests

A sample report request has the following format:

Sample EDCT Report Request
(Line Numbers for Reference Only)

(1) EDCT LIST
(2) EDCT SUB SHOW
(3) EDCT SLIST

(4) EDCT UNASSIGNED SLOTS

Table 3-V below presents a breakout of the EDCT Report Request. Sections
3.2.1.3.2.9 through 3.2.1.3.2.12 describe the format of each of the report response
messages.

Table 3-V. Report Request

Field/Line Designation Unit/Format Description Bytes

Line 1-n: Request(s). The packet can include one or more requests. Each requested report comes back
as a separate message. Possible request types are listed below

1

EDCT LIST EDCT LIST Returns a list of all airports that | 9
currently have GDPs. (See
3.2.1.3.2.15 below)

EDCT SUB SHOW EDCT SuB Returns the substitution status | 13
SHOW (on or off) at all airports that
currently have GDPs (sub
status is also part of the EDCT
LIST report) (See 3.2.1.3.2.16
below)

EDCT SLIST EDCT SLIST | Returns a slot list for the | 15-68
aaa [aaa]...[aaa] | requested airport. Unlike the
slot lists when the GDP is
issued, the EDCT SLIST report
returns a single list that
includes all flights affiliated
with the requesting airline. That
is, the reply can include
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Field/Line Designation Unit/Format Description Bytes
different 3-letter airline codes
in one report
4 Returns a list of unassigned

EDCT EDCT slots, similar to the ADL 21

UNASSIGNED UNASSIGNED | UNNASSIGNED_SLOTS

SLOTS SLOTS block

3.2.1.3.2.9 EDCT LIST

This message returns a list of all airports that currently have GDPs. A sample EDCT
LIST has the following format:

Sample EDCT LIST
(Line Numbers for Reference Only)

(1) Number of airports currently controlled: 3

(2)

(3) DEST TIMES CONTROL FLIGHTS SUBS SCS AC
(4) ————— e
(5) EWR /19/01/ EDCT+DAS 255 ON ON ON
(6) JFK /20/23/ GS 47 OFF OFF ON

(8) Bridging status at EWR:
(9) - Carriers which turned bridging OFF:
(10) USA

(11) Bridging status at JFK: ON.

(13) Number of FCAs currently controlled: 1

(14)
(15) FCA TIMES CONTROL FLIGHTS SUBS  SCS AC
(16) == mmm oo -
(17) FCAA02 /18/23/ EDCT+DAS 24 ON ON OFF
(18)

(19) Bridging status at FCAA(O2: ON.
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(21)
and military.
(22)
(23)

Printer:

Sfsa.//wkstn32

Bridging turned OFF permanently for non-CDM general aviation

Table 3-VI1 below presents a breakout of the EDCT List

Table 3-VI. EDCT List

Field/Line Designation Unit/Format Description Bytes

1 Number of | NUMBER OF | The number of airports that | 42-43

Controlled Airports AIRPORTS | currently have GDPs or GSs.
CURRENTLY
CONTROLLE
D: d[d]
Blank Line Separator Blank line separating data 1
Headers DEST Column Headers: 49
TIMES e DEST — Destination Airport
CONTROL | , TIMES- GDP/GS Time
FLIGHTS range
SUBicSCS « CONTROL - Type of
Control issued
e FLIGHTS — Number
affected
e SUBS - Substitution Status
e SCS - Slot Credit
Substitutions Status
e AC - Adaptive
Compression Status
4 Dashed Line | -------mmmmmmmeee- Dashed line separator 49
Separator | —ememeeeememeee-

5 Destination Laa[a] Destination airport in three or 8
four character identifier. This
entry is padded with spaces to
equal 8 bytes.

5 Times /dd/dd Start and end times of the GDP 9
or ground stop in the following
format: /hh/hh (hour start and
hour end in sequence)

This entry is padded with spaces
to equal 9 bytes.

5 Control LL[LL...LLL] | Control Type issue: May be 12
more than one entry. If so, each
entry will be joined by a plus
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Field/Line Designation Unit/Format Description Bytes
sign. This entry is padded with
spaces to equal 12 bytes.
5 Flights d[d][d][d] Number of flights that are 10
affected by the Control. In as
many digits are necessary to
detail. This entry is padded with
spaces to equal 10 bytes.
5 Sub Status ON Status of substitutions: One of 7
or two entries:
OFF « ON
e OFF
This entry is padded with spaces
to equal 7 bytes.
5 SCS Status ON Status of Slot Credit 2-3
or Substitutions. One of two
OFF entries:
e ON
e OFF
5 AC ON Adaptive Compression Status. 2-3
or One of two entries:
OFF e YES
¢ NO
6 —#n Multiple entries are possible | 48-49
containing the items listed as | per line
Field/Line 5.
Blank Line Separator Blank line separating data 1
Bridging Status BRIDGING | Status of bridging for individual 23
STATUS AT | GDPs.
Laa:
9 Bridging Off - CARRIERS | If bridging is off, the report lists 39
WHICH each carrier that currently has
TURNED bridging off for that GDP. This
BRIDGING | field is led by two blank spaces.
OFF:
10 Carrier List LLL [LLL] | Carriers which have turned 3-68
Bridging off. This field is led by
4 blank spaces.
11 Bridging Status BRIDGING | Status of bridging for individual 28
STATUS AT | GDPs, indicating Bridging is
Laa: ON ON.
12 Blank Line Separator Blank line separating data 1
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Field/Line Designation Unit/Format Description Bytes

13 Number of | NUMBER OF | Number of controlled FCAs. In 38-39

Controlled FCAs FCAS one or two digits
CURRENTLY
CONTROLLE
D: d[d]
14 Blank Line Separator Blank line separating data 1
15 Headers FCA TIMES | Column Headers: 49
CONTROL | « FCA—FCA Identifier
FLIGHTS | . TIMES- GDP/GS Time
SUBS SCS range
AC o CONTROL — Type of
Control issued
e FLIGHTS — Number
affected
e SUBS - Substitution Status
e SCS - Slot Credit
Substitutions Status
o AC - Adaptive
Compression Status
16 Dashed Ling | ---m-mmmmmmmmmeeeen Dashed line separator 49
Separator | mmemmmmemmemeee

17 FCA Identifier FCAaaa FCA in six character identifier. 8
This entry is padded with spaces
to equal 8 bytes.

17 Times /dd/dd Start and end times of the GDP 9
or ground stop in the following
format: /hh/hh (hour start and
hour end in sequence)

This entry is padded with spaces
to equal 9 bytes.

17 Control LL[LL...LLL] | Control Type issue: May be 12
more than one entry. If so, each
entry will be joined by a plus
sign. This entry is padded with
spaces to equal 12 bytes.

17 Flights d[d][d][d] Number of flights that are 10
affected by the Control. In as
many digits are necessary to
detail. This entry is padded with
spaces to equal 10 bytes.

17 Sub Status ON Status of substitutions: One of 7

or two entries:
OFF e ON
e OFF
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Field/Line Designation Unit/Format Description Bytes
This entry is padded with spaces
to equal 7 bytes.
17 SCS Status ON Status of Slot Credit 2-3
or Substitutions. One of two
OFF entries:
e ON
o OFF
17 AC Status ON Adaptive Compression Status. 2-3
or One of two entries:
OFF e On
o Off
17—#n Multiple entries are possible | 48-49
containing the items listed as | per line
Field/Line 17.
18 Blank Line Separator Blank line separating data 1
19 Bridging Status BRIDGING | Status of bridging for individual 23
STATUS AT | AFPs.. Same format as for
FCAaaa: ON | GDPs
20 Blank Line Separator Blank line separating data 1
21 System Bridging | BRIDGING | Status of bridging for the 74
Status TURNED OFF | system. This applies to both
PERMANENT | GDPs and AFPs. (NOTE: This
LY FOR line continues out past the right
NON-CDM margin.)
GENERAL
AVIATION
AND
MILITARY.
22 Blank Line Separator Blank line separating data 1
23 ; .| Location of the printer at the
Printer PRINTER: command center. (NOTE: This 24
aaaa./aaaaaaaa | s of no use for the NAS user.)
3.2.1.3.210  EDCT SUB SHOW

This message returns the substitution status (on or off) at all airports that currently
have GDPs (sub status is also part of the EDCT LIST report) as well as the
substitution status for all FCAs that have AFPs. A sample EDCT SUB SHOW report

has the following format:
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Sample EDCT SUB SHOW
(Line Numbers for Reference Only)

(1) Current Time: 18:06:17 on 7/29/2005

(2)

(3) Airport SUB Processing Activated SCS Processing Activated AC Active
(4) mm e e -
(5) EWR Yes Yes Yes

(6) JFK No No No

(7)

(8) Bridging status at EWR:

(9) - Carriers which turned bridging OFF:

(10) USA

(11) Bridging status at JFK: ON.

(12)

(13) FCA SUB Processing Activated SCS Processing Activated AC Active
(14)  mm e e
(15) FCAAQ2 Yes Yes No
(16)

(17) Bridging status at FCAA02: ON.
(18)
(19) Bridging turned OFF permanently for non-CDM general aviation ..
(20)
(21) Printer: S$fsa.//wkstn32
Table 3-VII below presents a breakout of the EDCT Sub Show
Table 3-VII. EDCT Sub Show
Field/Line Designation Unit/Format Description Bytes
1 Current Time and CURRENT | Current Time and Date of 40
Date message in format hh:mm:ss on
TIME: M[M]/D[D]/YYYY
dd:dd:ddON |, hh— hour

dldyd[dl/dddd |+ mm_ minute
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This entry is padded with spaces
to equal 26 bytes.

Field/Line Designation Unit/Format Description Bytes
e Ss—second
e M[M] - Month in one or
two digits
e D[D] - day in one or two
digits
e YYYY - Year
2 Blank Line Separator Blank line separating data 1
3 GDP Headers AIRPORT Column Headers: 59
SUB  Airport — Destination
Airport
PROCESSING . .
o Sub Processing Activated—
ACTIVATED Substitution Processing on
SCS or off
PROCESSING | * SCS Processing Activated —
Slot Control Substitution
ACTIVATED Processing on or off
AC « Adaptive Compression
ACTIVATED Activated on or off
4 Dashed Line | oo Dashed line separator 49
Separator
S Airport Laa[a] Destination airport in three or | 11
four character identifier. This
entry is padded with spaces to
equal 11 bytes.
S Sub Processing YES Substitution Processing Status. 26
One of two entries:
or
¢ YES
NO « NO
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Field/Line Designation Unit/Format Description Bytes
S SCS Processing YES Substitution Processing Status. 2-3
One of two entries:
or
¢ YES
NO .« NO
S AC Activated YES Adaptive Compression Status. 2-3
One of two entries:
or
¢ YES
NO .« NO
6—#n Multiple entries are possible | 48-49
containing the items listed as )
Field/Line 5. per line
7 Blank Line Separator Blank line separating data 1
8 Bridging Status BRIDGING | Status of bridging for individual 23
GDPs.
STATUS AT
Laa:
9 Bridging Off - CARRIERS | If bridging is off, the report lists 39
each carrier that currently has
WHICH bridging off for that GDP. This
TURNED field is led by two blank spaces.
BRIDGING
OFF:
10 Carrier List LLL [LLL] | Carriers which have turned 3-68
Bridging off. This field is led by
4 blank spaces.
11 Bridging Status BRIDGING | Status of bridging for individual o8
GDPs, indicating Bridging is
STATUSAT | N
Laa: ON
12 Blank Line Separator Blank line separating data 1
13 FCA Header FCA Column Headers: 59
SuUB e FCA —FCA Number
PROCESSING | ® Sub Processing Activated—
ACTIVATED Sub Processing on or off
e SCS Processing Activated —
SCS Slot Control Substitution
PROCESSING processing on or off
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Field/Line Designation Unit/Format Description Bytes
o Adaptive Compression
ACTIVATED Activated on or off
AC
ACTIVATED
14 Dashed Line | oo Dashed line separator 49
Separator
15 FCA Identifier FCAaaa FCA in six character identifier. 8
This entry is padded with spaces
to equal 8 bytes.
15 Sub Processing YES Substitution Processing Status. | 26
One of two entries:
or
¢ YES
NO . NO
This entry is padded with spaces
to equal 26 bytes.
15 SCS Processing YVES Substitution Processing Status. | 2.3
One of two entries:
or
e YES
NO « NO
15 AC Active Yes Adaptive Compression Status. | 2.3
or One of two entries:
No ¢ YES
¢« NO
15-#n Multiple entries are possible | 4g8-49
containing the items listed as )
Field/Line 17. per line
16 Blank Line Separator Blank line separating data 1
17 Bridging Status BRIDGING | Status of bridging for individual 23
AFPs. Same format as for
STATUSAT | gpps.
FCAaaa: ON
18 Blank Line Separator Blank line separating data 1
19 System Bridging BRIDGING | Status of bridging for the 74
Status system. This applies to both
TURNED OFF | Gpps and AFPs. (NOTE: This
PERMANENT | line continues out past the right
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Field/Line Designation Unit/Format Description Bytes
LY FOR margin.)
NON-CDM
GENERAL
AVIATION
AND
MILITARY.
20 Blank Line Separator Blank line separating data 1
21 Printer PRINTER: Location of the printer at the 24
command center. (NOTE: This
aa2./a2aaadad | s of no use for the NAS user.)

3.2.1.3.2.11 EDCT SLIST
The EDCT SLIST request returns the same format used to issue a GDP/AFP, or to
reply to an SS message. A sample EDCT SLIST report (for an AFP) has the
following format:
Sample EDCT SLIST
(Line Numbers for Reference Only)

(1) SLOT LIST FOR FCAAQ2

(3) ACID ASLOT DEP ARR CTD CTA TYPE EX CX SH EENTRY IGTD

(4) ABC1234 FCAA02.260400A DCA LGA 260300 260400 AFP - - - 260400 260245
ABC5678 FCAA02.260500A IAD BOS 260400 260500 AFP - - - 260300 260145
ABC360 FCAA02.260323A CYYZ LGA 260206 260323 AFP Y - - 260319 260150
ABC3522 FCAA02.260311A DCA BOS 260215 260311 AFP - - - 260311 260145
ABC39 FCAA02.260353A ROC LGA 260246 260353 AFP - Y - 260355 260235

Table 3-VIII below presents a breakout of the EDCT SLIST.
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Table 3-VIII. EDCT SLIST

Field/Line Designation Unit/Format Description Bytes
1 Slot List Identifier SLOT LIST | Identifies airport or FCA that the | 17-20
FOR FCAaaa | slot list is for.
or
SLOT LIST
FOR aaa
Blank Line Separator Blank line separating data 1
Slot List Data ACID Header for the following Slot 64
Headers ASLOT List data fields:

DEP ARR e ACID - Aircraft identifier
e ASLOT — Arrival Slot

CTD CTA )
TYPE EX CX e DEP — Departure Airport
e ARR - Arrival Airport
SH e CTD - Controlled Time of
EENTRY (or) Departure
ERTA o CTA —Controlled Time of
Arrival
IGTD e TYPE - Type of Entry
e EX - Exempt Flag (Yes or
No)
e CX-—Control Flag (Yes or
No)
e SH - Slot Hold flag (Yes or
No)

e EENTRY - Earliest Entry
Time (for AFP)
or
ERTA - Earliest Runway
Time of Arrival (for Airport
GDP)

e |IGTD - Initial Gate Time of
Departure

4-n Refer to Table 3-I11 for detailed

Slot List Data Fields
breakout.

*Note — There may be multiple rows of data under the header.
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3.2.1.3.2.12

EDCT UNASSIGNED SLOTS

The EDCT UNASSIGNED SLOTS will contain a list of unassigned slots that have
not yet been allocated to flights. An example is provided below, followed by a
detailed breakout in Table 3-IX.

Sample Unassigned Slots Blocks

EDCT UNASSIGNED

EWR.191233A EWR.

EWR.191241A EWR.

EWR.191249A EWR.

EDCT UNASSIGNED

SLOTS

191234A EWR.191235A EWR.191236A EWR.191237A

1912427 EWR.191243A EWR.191442A EWR.191245A

191250A EWR.191251A EWR.191252A EWR.191253A

SLOTS

FCAO027.191233A FCAQ027

FCAO027.191241A FCAQ027

FCAO027.191249A FCAQ027

.191234A FCAO027.191235A FCA027.191236A

.191242A FCAQ027.191243A FCA027.191442A

.191250A FCAO027.191251A FCA027.191252A

EWR.191238A

EWR.191246A

EWR.191254A

FCA027.191237A

FCA027.191245A

FCA027.191253A

Table 3-1X. EDCT UNASSIGNED SLOTS

Line Function Unit/Format Description Bytes
1 : Static Entry: EDCT
I 21
Unassigned Slots EDCT UNASSIGNED SLOTS
title UNASSIGNED
SLOTS
2 Blank Line Blank Line Separator 1
3-n Unassigned Slot LLL.dddddda The b_Iock contains a list of
) unassigned slots that have not
entries (GDP) yet been allocated to flights. 15-75*
or Two different entries are used:
e GDP — The formatting for
FCAaaa.dddddda GDP is
(AFP) - Airport Name — three
letters
or ~  Slot number - six digits,
NONE followed by one
alphanumeric character.
(Empty)
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Line Function Unit/Format Description Bytes
e AFP — The formatting for
AFP is

- FCA Identifier — three
letters FCA followed by
three alphanumeric
characters

- Slot number — six digits,
followed by one
alphanumeric character.

3.2.1.3.2.13 Delay Program Rate Messages

FSM transmits Delay Program arrival and departure rates (AAR and ADR
respectively) using the messages listed below that are described in Appendix D.
Delay Program Rate Messages are received when an Actual Delay Program is
initiated. Delay Program Rate Messages are not received for Proposed Delay
Programs.

« M_ADD_ADL_AAR _GDP
« M_DEL_ADL_AAR_GDP

The format of the Delay Program Rate Messages is internal to FSM. TFMS treats the
Delay Program Rate Message as a simple text string that is extracted, retained and
inserted into the ADL for the associated control element. The exception to this is the
Control Element name (i.e., airport or AFP name) as well as the time. These are the
first two elements in the Delay Program Rate message. Table 3-X describes he
format of the Delay Program Rate Message.

Table 3-X. Delay Program Rate Message

Field Function Unit/Format Description Bytes
The name of the airport, FEA
1 | El ! 1 1 7
Contr-o- ement aaa or FCAaaa or FCA to which the data rates >
Identifier Or aaaaaa in this message are associated.

The alphanumeric string is

followed by a blank.

o For airports — three or four
alpha-mumeric character
airport identifier

e For FEAs — up to six
characters limited to upper
case alpha-numeric, “-“, and
“ ”. Characters may be used
in any position except that “-
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Field Function Unit/Format Description Bytes

“, and “_” may not be used in
the last position. NOTES -
FEA names are not
guaranteed to be unique and
can duplicate airport names,
in such a case they should not
be considered to be the same
element. FEA names can be
reused within the same day,
in such a case they should not
be considered to be the same
element.

e For FCAs - six alpha-numeric
characters beginning with
“FCA”.

: Date and time expressed as
2 Time ddaddddd DDHHMMSS. Often referred to o
as the “FADT Report Time”. 8
digits of time are followed by a
blank.

The AAR_TIME (or

. . -
3 Aircraft Arrival (or AAR_TIME ADR_TIME) value consists of 27-87
Departure) Rate dddddd IDX three entries:
Time and d[d] AAR-d[d] | e The date/time of the first 15
minute period to which the
Incremental Rates [ddx20] or first AAR (or ADR) should
ADR_TIME be applied. Format is
dddddd 1DX dohhmm.

e The code “IDX ddd” is for
d[d] ADR-d[d] uses other than TFMS and is
[ddx20] ignored.

e The remaining AARs (or
ADRs) are for the subsequent
15 minute periods after the
start date/time, in one or two
digits.

¢ Note — The maximum stated here is for a single data line. There may be multiple lines of
data as necessary.

3.2.1.3.2.14 Delay Program Parameters Messages

FSM notifies TFMS of delay program parameters for GDPs, AFPs, and GSs using
the following messages that are described in Appendix D. Delay Program Parameter
Messages are received for both Proposed and Actual Delay Programs. There is a
separate message for original program parameters as well as separate parameters for
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compression and blanket revisions to an existing delay program.

M_ADD_ADL_GDP_PARAM
M_ADD_ADL_COMP_PAPAM
M_ADD_ADL_BLANK_PARAM
M_ADD_ADL_GS_PARAM
M_ADD_ADL_AFP_PARAM
M_DEL_ADL_GDP_PARAM
M_DEL_ADL_COMP_PAPAM
M_DEL_ADL_BLANK_PARAM
M_DEL_ADL_GS_PARAM
M_DEL_ADL_AFP_PARAM

See Appendix C FSM ADL Parameters Specification for a detailed description of the
individual parameters.

3.2.1.3.2.15 Heartbeat Message

Heartbeat messages are simply a brief exchange of heartbeat requests and responses
between FSM and the TFMS to indicate the system is still functional, if there has
been no message traffic between the two for a specified amount of time. It consists
of a request message (M_HB_REQ) from the FSM and a response message
(M_HB_ACK) from TFMS. FSM sends the M_HB_REQ message to TFMS,
requesting a heartbeat message to confirm that the connection is still active. TFMS
sends back the M_HB_ACK message with an acknowledgement. Appendix D
provides the record layout of these two messages.

3.2.1.3.3 Information Unit Segmentation
The TFMS-to-FSM APs are not required to perform message segmentation.

3.2.1.3.4 Direction of Information Flow

The information flow between FSM and TFMS is bi-directional. The flow of
individual messages is detailed in Table 3-V.

3.2.1.3.5 Frequency of Transmission

All message traffic in the TFMS-to-FSM interface is dynamic, with data sent when it
is required.

3.2.1.3.6 Responses

Refer to Section 3.2.2.1 for session messages and responses, detailing required
responses.

3.2.1.4 Quality of Service
Not Applicable.
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3.2.1.5

3.2.1.6

AP Error Handling

The FAA will send a response to every SS message packet, to the return address on
the incoming message. If errors are detected in the SS packet, the entire packet is
rejected. The response to the error includes the packet identifier, a message
indicating it was rejected, and the number of errors. For each error, the response
shows the SS message that triggered the error and the reason for the error. (For a
complete listing of Error messages, refer to Table 3-1V.)

Loss of FSM

TFMS will consider any of the following events to be a “loss of FSM™:

« Notification that a message is undeliverable
e An excessive backup in the sending queue (see below)
e Receipt of a disconnect message

Loss of TEMS

FSM will consider any of the following to be a “loss of TFMS™:

« Notification that the connection to the server has been lost
« Notification that a message to the server is undeliverable
e Receipt of a shutdown message

In addition, TFMS will queue ADL files intended for FSM in the event that the
socket is not being read as fast as it is being written. A maximum queue of 50 ADL
files will be allowed. Once the maximum is exceeded, TFMS will consider FSM to
be inaccessible and will terminate the session.

Summary Table

An interface summary table (see Table 3-XI below) shows the association between
the messages that flow across the interface and the APs of the interfacing
subsystems. The left side of the interface summary table column lists the TFMS APs.
The center columns contain the names of the messages transferred and the direction
of transfer flow. The right hand column lists the FSM APs.

Table 3-XI. TFMS-to-FSM Interface Summary

Subsystem A Flow Subsystem B
TFEMS AP Messages Direction FSM AP
FAA Portal Aggregate Demand List A—B FSM Server
External Portal Aggregate Demand List A—B FSM Server
FAA Portal FSM Broadcast Request A«<B FSM Server
External Portal FSM Broadcast Request A«<B FSM Server
FAA Portal FSM Broadcast Reply ASB FSM Server
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Subsystem A Flow Subsystem B
TFMS AP Messages Direction FSM AP
External Portal FSM Broadcast Reply AsB FSM Server
FAA Portal FSM Broadcast Message A<B FSM Server
External Portal FSM Broadcast Message A<B FSM Server
FAA Portal EDCT Change Request Messages A<——B FSM Server
External Portal Slot Credit Substitution Messages A«<——B FSM Server
FAA Portal Substitution Good Responses A<—B FSM Server
External Portal Substitution Good Responses A——B FSM Server
FAA Portal Substitution Error Responses A<——B FSM Server
External Portal Substitution Error Responses A<——B FSM Server
FAA Portal EDCT Commands/Replies A<——B FSM Server
External Portal EDCT Commands/Replies (EDCT Report A B FSM Server
Requests/Reports)
FAA Portal Delay Program Rate Messages A«<B FSM Server
External Portal Delay Program Rate Messages A«<B FSM Server
FAA Protal Delay Program Parameters Messages A«<B FSM Server
External Portal Delay Program Parameters Messages A«<B FSM Server
FAA Portal Heartbeat Message A«B FSM Server
External Portal Heartbeat Message A«B FSM Server

3.2.2 Protocol Implementation

The TFMS to FSM interface communications functions are implemented according
to OSI reference model as defined in FAA-STD-039b, Open Systems Architecture
and Protocols, and FAA-STD-043b, Open System Interconnect Priority.
Subsection 3.2.2 documents the OSI protocols implemented for each layer of the
interface.

a.

Application Layer (Layer 7) - This layer is not implemented within the

TEMS-to-FSM interface.

Presentation Layer (Layer 6) — This layer is not implemented within the

TEMS-to-FSM interface.

Session Layer (Layer 5) - This layer is not implemented within the TFMS-to-

FSM interface.

Transport Layer (Layer 4) - The TFMS-to-FSM interface uses the TCP, in
accordance with RFC793, Transmission Control Protocol, Sep 1983, as its

Transport layer protocol.

Network (Packet) Layer (Layer 3) - The TFMS-to-FSM interface uses the
standard IP RFC791, Internet Protocol, Sep 1981, as its Network layer

protocol.
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f.  Data-Link (Frame) Layer (Layer 2) — The TFMS-to-FSM uses the 100-baseT
Ethernet standard in accordance with IEEE 802.3, IEEE Standard for
Information Technology — Telecommunications and Information Exchange
Between Systems, 2000 as the Data Link Layer

g. Physical Layer (Layer 1) — The Physical layer of the TFMS-to-FSM interface
uses a standard Category 5 (Cat-5) Ethernet cable as its Physical layer
protocol.

Figure 3-2, OSI Layer Functional Interface Connectivity Diagram for TFMS-to-
FSM, gives a visual representation of the OSI layers and their structure.

OSI Layer Functional Interface Connectivity Diagram for TFMS-to-FSM

Application < > Application
Processes Processes
APPLICATION €« ——|— — — — — — — A — — —»  APPLICATION
PRESENTATION PRESENTATION
SESSION SESSION
TCP Protocol
TRANSPORT -~ — —|— — — — — — — - —— TRANSPORT
IP Protocol
NETWORK €« — —|— — — — — — — A - — — > NETWORK
100 base T Ethernet
DATA LINK €~ — —|— — — — — — — - — — > DATA LINK
PHYSICAL < > PHYSICAL

Implemented by a Category
5 (Cat-5) Ethernet cable

TFMS FSM

Dotted lines represent standards and or protocols employed
Solid lines represent applications and / or physical connections employed

Figure 3-2. OSI Layer Functional Interface Connectivity Diagram for TFMS-to-FSM

3.2.2.1 Application Services

This section details the application and connectivity of the FSM interface. TFMS-to-
FSM interface uses CDM Session protocols and a number of other sub-protocols to
initiate and a session with the clients and exchange data. These protocols are defined
in detail in Appendix D.

3.2.2.2 Network Services

3-41



TFMS-to-FSM Interface Control Document CSC/TFMM-10/1077
March 2011 Release 5 FINAL, Revision 1 Interface Characteristics

3.2.2.3

3.2.3

3.24

The TFMS-to-FSM interface uses the established standards of Transmission Control
Protocol (TCP) in accordance with RFC 793, Transmission Control Protocol, and
Internet Protocol (IP) in accordance with RFC 791, Internet Protocol, Sep 1981.

Naming and Addressing
ADL and FSM Broadcast
Naming conventions are used for the exchange of ADL and FSM Broadcast files.

These conventions are described in Appendix B ADL & Broadcast File Format
Specifications.

Substitution Messages

The first line of the substitution message is the Packet header, consisting of the
letters “SS”, followed by a space, followed by a unique packet identifier. The packet
identifier consists of:

e  The three-letter user code
e Aten-digit transmission date/time in the format MMDDhhmmss
e A period (“.”)

e A two-digit suffix - The two-digit suffix may be used to create unique
identifiers when multiple messages are generated in the same second. Otherwise
the user can set the suffix to any desired two digits.

Report Requests and EDCT Lists

No header or addressing is required for this report. The direct IP address of the
connection is sufficient, along with the format of the messages. (Refer to Sections
3.2.1.3.2.8 through 3.2.1.3.2.12 for formats of these messages.)

Security

TFMS implements FAA information security guidelines in accordance with
Information Systems Security Plan (ISSP) for Traffic Flow Management—
Modernization (TFM-M), the FAA Information Systems Security Program, FAA
Order 1370.82A, and FAA-STD-045, OSI Security Architecture, Protocols and
Mechanisms. It will enact security strategies and measures on all incoming
information into TFMS.

Interface Design Characteristics Table

Subsection 3.2.4 summarizes the interface functional design characteristics in an
Interface Design Characteristics Table (See Table 3-XII below) in addition to the
text. The Interface Design Characteristics Table serves as a "quick-look™ reference.

Table 3-XIl. Interface Design Characteristics of the TFMS to FSM Interface

Message Name Format SiEE UIAE Frequenc
9 (Bytes) | Constraints 9 y
Aggregate Demand List ASCII 2,900/ As required
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Size Time
Message Name Format . Frequency
(Bytes) | Constraints
8,761
FSM Broadcast Request ASCII 24 As required
FSM Broadcast Reply ASCII 24 As required
FSM Broadcast Message XML 1307/ Every 5
1764* minutes**
Slot Credit Substitution Message ASCII 40/46 As required
Substitution Good Responses ASCII 56/60 In response to
SS Packet
Substitution Error Responses ASCII 141/213* In response to
SS Packet
EDCT and Other Commands ASCII 35/103 As required
EDCT and Other Command Replies ASCII 238/1468 As required
Delay Program Rate Messages ASCII 192 As required
Delay Program Parameters Messages ASCII As required
Heartbeat Message ASCII 102 Every Five 1 per
minutes max minute***

all entries do not exceed one line.

the time constraint period.

*Note — Some entries in these messages may require more than one line of entry. The given maximum is valid if

** Note - The file will be broadcast at a regular 5 minute interval, except that the following events will trigger a
new file irrespective of the set interval:

e When a TMI is processed by TFMS
e When a FEA/FCA is created, modified, or removed
e When requested by an application

***Note — Heartbeat message is transferred from FSM to TFMS if no data has passed through the interface within

3.3 Physical Design Characteristics

As stated in Section 3.1, the TFMS-to-FSM Interface uses three forms of
communication paths to transfer data. Figure 3-3 below, details each of these
communications paths and their related physical configurations. The demarcation
points are denoted as circled dots in the figure.

3-43




TFMS-to-FSM Interface Control Document CSC/TFMM-10/1077
March 2011 Release 5 FINAL, Revision 1 Interface Characteristics

TFMS-to-FSM Physical Diagrams

HP ProLiant
DL380

Cisco 3845
Integrated Services Router

. { ‘
| Firewalll | * ‘ A FSM Server (Internal TRSs)

Cisco
7206VXR

OS3AN - 114

o Canada Traffic
(gggggaétz_llysst I FSM Server (External TRS
- I and Canada)

:
L r
‘ FSM Server (CDM Sites)

Figure 3-3. TFMS-to-FSM Physical Diagrams
The four pathways are:

e Via Ops-IP WAN -The FSM Server routes data to the Ops-IP WAN. Data is
transferred by the standard TCP/IP protocols. TFMS uses the FAA Routers, a
pair of Cisco 3845 Integrated Services Router (designated FAARTR), to access
the Ops-IP WAN. The FAA Routers then pass the data to and from the Firewall.
The firewall passes data to and from the FAA Portal Message Interface Server,
an HP ProLiant DL380 (designated PRSR_3).

e Viathe AOCNET WAN - The FSM Servers using the AOCNet WAN connect
to the FTI-NESG. On the TPC side of the interface, the FTI- NESG connects to
ports on the two Cisco Catalyst 3560G switches (designated SWPT_4). The
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3.3.1

3.3.11

3.3.1.2

3.3.1.3

3.3.14

3.3.15

data flows through the Cisco 7206 Router/Switch (designated EXTRTR). The
physical demarcation point is at the TPC's SWPT_4 switches.

e Via VPN/Internet via the NESG connection - The FSM servers using the
VPN/INTERNET, connect to the FTI- NESG. On the TPC side of the interface,
the connectivity follows the same path into the TFMS subsystems as described
in the AOCNET WAN connectivity above.

e Via leased circuit into the FTI-NESG — The FSM servers from the Canadian
Command Center connect to the FTI-NESG via a leased circuit. On the TPC
side of the interface, the connectivity follows the same path into the TFMS
subsystems as described in the AOCNET WAN connectivity above.

Electrical Power and Electronic Characteristics

There are no specific 3.3.1 characteristics applicable to the TFMS-to-FSM interface
No subsystems supply electrical, mechanical, or environmental support to another
subsystem, Systems supply their own discrete power and do not support each other
in this manner.

Connectors

The TEMS-to-FSM interface uses a standard RJ-45 Ethernet connection as the
interface connection. Standard RJ-45 pin assignments are used.

Wire/Cable

Standard Cat5 Ethernet cabling with RJ-45 connectors are used in the TFMS-to-FSM
interface.

Electrical Power/Grounding

There are no specific 3.3.1.3 characteristics applicable to the TFMS-to-FSM
interface

Fasteners

There are no specific 3.3.1.4 characteristics applicable to the TFMS-to-FSM
interface

Electromagnetic Compatibility

There are no specific 3.3.1.5 characteristics applicable to the TFMS-to-FSM
interface.
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4

Verification Provisions

4.1

41.1

4.1.2

4.1.3

4.2

Responsibility for Verification
e Following are verification provisions for the TFMS-to-FSM interface:

e Pre-OT&E (Operational Testing and Evaluation)
e OT&E
e KSAT (Key Site Acceptance Test)

Pre-OT&E

Pre-Operational Test and Evaluation (OT&E) testing is performed to verify the
operational viability of the TFMS-FSM interface and data stream prior to formal
testing. FSM message exchange is available within this test phase but testing may
be performed using simulated data. Pre-OT&E testing verifies that the end systems
comply with and utilize the messages and formats as specified in this ICD. This test
is conducted by both end systems as part of their informal system tests using their
own test plans and test procedures. It is conducted at their respective test facilities.
The William J Hughes Technical Center (WJHTC) TFMS Test Facility (TF) is
designated as the test facility for the TFMS system. Pre-OT&E testing of TFMS is
performed in accordance with FAA-approved test plans and procedures. TFMS test
results are provided to the FAA. A TPC Auxiliary Platform (TAP) at the WIJHTC is
configured with the appropriate TFMS release software to support FSM testing (refer
to Section 4.2 Test Environments).

OT&E

The OT&E tests are live tests conducted formally by the FAA with CSC support at
the TPC. They include the Air Traffic Control System Command Center (ATCSCC)
“early look™ tests with the participation of FAA field personnel. Among other
things, these tests verify end to end connectivity between TFMS and the FSM.

KSAT

The Key Site Acceptance Test (KSAT) focuses on TFMS functionality and
connectivity tests. It is conducted under operational conditions, performed with live
data between the TPC, the ATCSCC and an FAA-selected Air Route Traffic Control
Center (ARTCC) site.

Test Environments

The TFMS-FSM test environment consists of a TPC Auxiliary Platform (TAP) that
is configured with the FSM software for CDM user community pre-production
testing. Each TAP is a separate test environment, loaded with either the current
operational TFMS release or the next version to be released. Each TAP is isolated
from the operational system and is configured to receive one way flow of live flight
data from a message forwarding component of the TFMS operational system. Non-
operational data on a TAP is not enabled to flow into the operational system.
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Access to the test environments for CDM customers requires that a separate
connection be created to access the TAPs. Current operational CDM network
connections (Ops) are not permitted to access the test environments. A separate non-

operational service delivery point or gateway (referred to as the FAA National Test

Bed or FNTB) provides isolation from the operational system and access to the
TFMS test environments.

4.3 Special Verification Requirements

No special verification requirements exist for this ICD.

4.4 Verification Requirements Traceability Matrix (VRTM)
No VRTM is required for this ICD.
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5 Preparation for Delivery

There are no specific preparations for delivery applicable to the TFMS-to-FSM
interface.
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6 Notes
6.1 Definitions
None
6.2 Abbreviations and Acronyms

This section provides a definition of acronyms contained within this ICD.

AAR
ABRG
AC
ACENTR
ACID
ADC
ADCUS
ADL
ADPT
ADR
AFIX
AFP
AGL
ALD
ALM
ALTRV
ANSI
AOCNET
AP

APT
ARINC
ARR
ARTA
ARTCC
ARTD
ASCII
ASLOT
ATC
ATCSCC
ATV

BECMG
BENTRY
BETA
BETD
BKT

Aircraft Arrival Rate

Adaptive Compression Bridging

Air Carrier

Arrival Center

Aircraft Identifier

Advise Customs Flag

ADCUS

Aggregate Demand List

Adaptive Compression

Aircraft Departure Rate

Arrival Fix

Airspace Flow Program

Above Ground Level

Airline Delayed Flag

Alarm

Altitude Reservation

American National Standards Institute
Airline Operation Center Network
Application Process

Airport

Aeronautical Radio Incorporated
Arrival

Actual Runway Time of Arrival

Air Route Traffic Command Center
Actual Runway Time of Departure
American Standard Code for Information Interchange
Assigned Arrival Slot

Air Traffic Control

Air Traffic Control System Command Center
Altitude Reservation Flag

“Becoming” Weather Forecast Change Indicator
Base Element Entry Time

Base Estimated Time of Arrival

Base Estimated Time of Departure

Blanket Program
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BKN Sky Condition Covered 5-7 8" Coverage
BLKT Blanket Program
CAT CAT-1ll Landing Requirements
CAVOK Ceiling and Visibility above Minimum Criteria
CDM Collaborative Decision Making
CLS Aircraft Class
CNX Cancel
COMP Compression
CONUS Continental United States
CSA Computer System Analyst
CT Control Time
CTA Controlled Time of Arrival
CTD Controlled Time of Departure
CTL Control
CTG Aircraft Category
CX Cancel Flag
DAS Delay Assignment
DCENTR Departure Center
DEP Departure Airport
DEST Destination Airport
DFIX Destination Fix
DID Data Item Description
DO Dropout Flag
DOD Department of Defense
DP Departure Procedure
DTRSN Departure Transition Fix
DV Diversion
DVREC Diversion Recovery
DVRSN Diversion Flight
DVT Diversion Recovery Flag
EAFT Earliest Arrival Fix Time
ECR EDCT Change Request
EDCT Estimated Departure Clearance Time
EDFT Earliest Departure Fix Time
EETA Earliest Estimated Time of Arrival
EENTRY Earliest Element Entry Time
ELEM Element Definition
ERTA Earliest Runway Time of Arrival
ETA Estimated Time of Arrival
ETD Estimated Time of Departure
ETE Estimated Time Error
ETMS Enhanced Traffic Management System
EX Exempt Flag
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FA Fuel Advisory
FAA Federal Aviation Administration
FADT Fuel Flow Advisory Delay Time
FCA Flow Constrained Area
FCM Federal Meteorological Handbook
FD Flight Data Packet
FEA Flow Evaluation Area
FLT Flight
FM “From” Weather Forecast Change Indicator
FSM Flight Schedule Monitor
FTI FAA Telecommunications Infrastructure
FX FX-message Cancelled Flag
GA General Aviation
GAAP General Aviation Airport Programs
GCD Great Circle Distance
GDP Ground Delay Program
GS Ground Stop
GSD Ground Stop Delayed
ICAO International Civil Aviation Organization
ICD Interface Control Document
ID Identification
IEC International Electrotechnical Commission
IEEE Institute of Electrical and Electronics Engineers
IENTRY Initial Element Entry Time
IGTA Initial Gate Time of Arrival
IGTD Initial Gate Time of Departure
INS Inches (Barometric pressure measurement
IP Internet Protocol
IR Interface Requirement
IRD Interface Requirement Document
IRS Interface Requirement Specification
ISO International Organization for Standardization
ISSP Information Systems Security Plan
KM Kilometer
KT Knot
LFG LIFEGUARD or Medevac Flight
LGTA Airline Gate Time of Arrival
LGTD Airline Gate Time of Departure
LRTA Airline Runway Time of Arrival
LRTD Airline Runway Time of Departure
LTOD Length of Time Out Delay
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METAR Meteorological Aviation Report
NAS National Airspace System
NM Nautical Mile
NRP National Route Program Flag
NSC No Sky Cover
NSW No Significant Weather
NWS National Weather Service
OAG Official Airline Guide
OCTA Original Controlled Time of Arrival
OCTD Original Controlled Time of Departure
OENTRY Original Element Entry Time
OETA Original Estimated Time of Arrival
OETD Original Estimated Time of Departure
ORIG Origin Airport
(ON]| Open Systems Interconnect
ovC Sky Condition Covered 8/8th
PGTA Proposed Gate Time of Arrival
PGTD Proposed Gate Time of Departure
PETE Proposed Enroute Time Error
PROB Probability Chance of Weather Occurrence
RCTL DAS Controlled Time
RFC Request For Comments
RBS Ration By Schedule
RM Remove Cancelled Flag
RS RZ-message Cancelled Flag
RZ NAS Cancelled Flag
SBRG SCS/ECR Bridging
SCS Slot Credit Substitution
SCT Sky Condition Covered 3-4 8" Coverage
SGTA Scheduled Gate Time of Arrival
SGTD Scheduled Gate Time of Departure
SH Slot Hold Flag
Sl Substitution
SM Statute Mile
SR System Requirements
SS Simplified Substitution Packet
SSR Slot Substitution Request
SSS System/Subsystem Specification
STAR Standard Terminal Arrival Route
STD Standard
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SUB Airline Substitution
SWP Severe Weather Avoidance Plan Flight Flag
TAF Terminal Aerodrome Forecast
TCP Transmission Control Protocol
TEMPO “Temporary” Weather Forecast Change Indic
TFM Traffic Flow Management
TFMI Traffic Flow Management Infrastructure
TFM-M Traffic Flow Management - Modernization
TFMS Traffic Flow Management System
TFMSID TFMS Aircraft Computer ID
T™MI Traffic Management Initiative
TO Time Out
TOD Time Out Delay
TPC TFMS Production Center
TRS TFMS Remote Site
TSD Traffic Situation Display
UBRG Control times were assigned when creating a bridge for pop-up flight
assignment during UDP.
UDP Unified Delay Program
UPD Update
USR User
uTC Universal Time Coordinate
UXx Update Cancelled Flag
VNTSC Volpe National Transportation Systems Center
VRTM Verification Requirements Traceability Matrix
\YAY Sky Condition Totally Obscured by Surface-based Phenomena
WMO World Meteorological Organization
WSOM Weather Services Operations Manual
WXR Severe Weather Reroute
WXRTE Severe Weather Reroute
XML Extensible Markup Language
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Appendix A FSM — TFMS Tools

(The following was excerpted from ETMS Reference Manual v8.5 Volume II: FSM User’s Guide, Section 3, item #5)

The ETMS Tools dropdown menu available on the main window of FSM contains seven core
options:

EDCT Commands,
Command Line,

Weather Request,

ADL Request,

ADL AAR,

ADL ADR, and

Delete Program Parameters.

Note: Only traffic management specialists at the ATCSCC have access to the ETMS Tools
menu.

ETMS Tools > EDCT Commands options:

- > EDCT CHECK - Displays the current status of a single flight controlled by an EDCT
program. When you issue this command, you get a one-line response showing the controlled
departure time and whether the ETMS has issued a Control Time (CT) message to
implement the control for this flight.

->EDCT CNX — Creates a report of all flights cancelled in EDCT programs for selected
airports or a report listing only cancelled flights for specified airlines for selected airports.

->EDCT CTA LIST — Creates a report of all controlled and cancelled flights for a data set
and/or an airline at a data set, as well as open slots.

->EDCT HOLD - Holds all slots in a GDP or AFP for all flights or only the flights
belonging to a specified airline and its sub-carriers at a specified Airport or Airspace data
set.

- > EDCT LIST — Creates a report containing a list of all data sets currently controlled by
EDCT programs.

->EDCT LOG - Creates a report of all EDCT files, cancellation messages, Simplified
Substitution (SS) processing messages, and EDCT updates processed by the system in the
order they were received.

- > EDCT PURGE — Purges EDCT flight controls for a specified Airport or Airspace data
set or for all data sets.

- > EDCT RELEASE — Releases all slots in a GDP or AFP for all flights or only the flights
belonging to a specified airline and its sub-carriers at a specified data set.

- >EDCT SCS OFF -Suspends slot credit substituting for flights controlled by EDCT
programs at a specified data set or at all data sets. To allow slot credit processing after
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suspending slot credit substituting, you must activate processing with the EDCT SCS ON
command.

- >EDCT SCS ON- Allows slot credit substituting for flights controlled by EDCT programs
at a specified data set or at all data sets. To prohibit slot credit substituting, you must
suspend processing with the EDCT SCS OFF command.

- > EDCT SHOW - Creates a report that contains detailed information on all flights
controlled by EDCT programs for a specified data set, or for all data sets.

- > EDCT SLIST — Provides a slot list (using the same format that goes to the airlines) for a
specified airport or an airline and its sub-carriers at a specified data set.

->EDCT SLOTS — Creates a report list of all open slots for airlines at specified data sets.

- > EDCT SUB OFF — Suspends Substitution processing (SI) messages for flights controlled
by EDCT programs at a specified data set or at all data sets.

->EDCT SUB ON - Allows Substitution processing (SI) for any flights controlled by
EDCT programs at a specified data set or at all data sets where substitution processing was
previously suspended.

- >EDCT AC OFF - Allows users to turn Adaptive Compression off by entering the airport
or FCA name, or ALL into the dialog box. Only Computer System Analysts (CSA) at the
Air Traffic Control Systems Command Center (ATCSCC) can use this command.

- >EDCT AC ON - Allows users to turn Adaptive Compression on by entering the airport,
FCA name, or ALL into the dialog box. Only Computer System Analysts (CSA) at the Air
Traffic Control Systems Command Center (ATCSCC) can use this command.

->EDCT SUB SHOW — Generates a report that shows the status of simplified substitution
processing (SS) messages for all data sets.

->EDCT UPDATE — Allows you to update a controlled flight with new departure and
arrival times. After you issue this command, you get a one-line response stating that the
update was successful.

->EDCT REMOVE - Allows you to remove flights from the ETMS database, as if they
never existed. Using this command can eliminate a duplicate flight or remove a specific
incorrect flight. Only Computer System Analysts (CSA) at the Air Traffic Control Systems
Command Center (ATCSCC) can use this command.

- > EDCT RESTORE — Allows you to “undo” the effects of the Remove command. It
allows some or all of the flights that you did not want to remove from the database to be
restored. Only Computer System Analysts (CSA) at the Air Traffic Control Systems
Command Center (ATCSCC) can use this command.

->EDCT UNASSIGNED SLOTS — Allows you to request, by airport identifier, an updated
unassigned slots list generated by the hub site.

e ETMS Tools > Command Line — Displays a dialog box which allows the user to enter any
EDCT FAA commands.

A-2



TFMS-to-AOCNET Interface Control Document CSC/TFMM-10/1077
March 2011 Release 5 FINAL, Revision 1 Appendix A

e ETMS Tools > Weather Request — Allows you to request current airport weather (METAR
and TAF) for one or more airports (use the three letter airport identifiers separated by
commas or spaces).

Note: Weather Request is not applicable to FCAs and FEAs.

e ETMS Tools > ADL Request — Allows you to request a new ADL generated from the hub
site for a particular data set.

e ETMS Tools > ADL AAR > Modify — Allows you to modify ADL Arrival Rates including
the ability to assign several different Airport Arrival Rates (AARS) within the same hour
(see Figure A-2).

e ETMS Tools > ADL AAR> Reset — Resets the Arrival Rate to the TFMS default arrival
rate.

e ETMS Tools > ADL ADR> Modify — Allows you to modify ADL Departure Rates
including the ability to assign several different Airport Departure Rates (ADRs) within the
same hour (see Figure A-2).

Note: ADL ADR is not applicable to FCAs and FEASs since departure rates do not apply to
airspace data sets.

e ETMS Tools > ADL ADR> Reset — Resets the Departure Rate to the TFMS default
departure rate.
Note: ADL ADR is not applicable to FCAs and FEAs since departure rates do not apply to
airspace data sets.

File Help

Hote
Click "Send’ to reset the ATL AAR values for inclusion in future ADLs.

Send Cancel Help

Figure A-1. Reset AAR Window

Note: When in Historical Mode, clicking Send resets the historical data to the first ADL
update time. Reset AAR/ADR Window Menu items:

o File>Open — Opens a file selection window that you can use to browse to a
previously saved rate file.

o File>Save As — Saves the current rates as a .txt file. You can give the file a unique
name and save it to a location of your choice.

o File>Print — Prints the AAR/ADR window data.

File > Close — Closes the Reset AAR/ADR window.

o Help > Demand Rates — Opens the on-line help information specific to the
modifying demand rates. In Monitored Live mode:

O
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= Click Send to reset AAR/ADR values to the default setting and send the
information to ETMS. The reset AAR/ADR is reflected in the next ADL
update.

= Click Cancel to close the Reset AAR/ADR window without taking any
actions.

= Click Help to display a pop-up screen with additional information on the
Send and Cancel buttons.

Use this component to change the AAR or ADR. The rates appear in the next ADL update.
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Click 'Send' to modify the BOS AAR rates for inclusion in future ADLs.

| Send || Cancel || Help |

Figure A-2. Modify AAR Window

ETMS Tools > Delete Program Parameters — Opens the Delete Program Parameters dialog

box (see Figure A-3). Select the airport or FCA for which you want to delete parameters

from the For Data Set drop down menu.
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5 Delete Program Parameters e[
For Data Set: |BOSLIWVE
Send Cancel Help

Figure A-3. Delete Program Parameters Window
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Appendix B ADL & FSM Broadcast File Format
Specifications

The content of this appendix is contained in a separate file that is represented by the
icon below and is linked to this document. To expand the ADL & FSM Broadcast
File Format Specifications file while viewing the ICD online, place your cursor on
the icon below and “Ctrl+click”. To print the contents of the ADL & FSM Broadcast
File Format Specifications file do one of the following:

« Open the ICD, navigate to this page, place the cursor on the icon below and
“Ctrl+click”. This will open the file in Microsoft Word. Use the Microsoft Word
print option.

e Open “Windows Explorer” and navigate to the directory containing this ICD.
Right click on the “ADL File Specification v12.4doc” file and select the “Print”
option.

@j

ADL File Specification
v12.4.doc
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Appendix C FSM ADL Parameters Specification

The content of this appendix is contained in a separate file that is represented by the
icon below and is linked to this document. To expand the FSM ADL Parameters
Specification file while viewing the ICD online, place your cursor on the icon below
and “Ctrl+click”. To print the contents of the FSM ADL Parameters Specification
file do one of the following:

« Open the ICD, navigate to this page, place the cursor on the icon below and
“Ctrl+click”. This will open the file in Microsoft Word. Use the Microsoft Word
print option.

e Open “Windows Explorer” and navigate to the directory containing this ICD.
Right click on the “FSM ADL Parameters Specification v5.4.doc” file and select
the “Print” option.

@j

FSM ADL Parameters
Spec v5.4.doc
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Appendix D CDM Message Protocol

There are four types of CDM message protocols:

e General CDM session Protocols
e ADL session Protocols

o Flight Data Message Protocols

o Simplified Substitution Protocols

With the exception of the Flight Data Message Protocols, the FSM interface utilizes
three of the above four message protocols. These protocols are detailed in the CDM
Message Protocol document that is represented by the icon below and is linked to
this document. To expand the CDM Message Protocol file while viewing the ICD
online, place your cursor on the icon below and “Ctrl+click™. To print the contents of
the CDM Message Protocol file, do one of the following:

« Open the ICD, navigate to this page, place the cursor on the icon below and
“Ctrl+click”. This will open the file in Microsoft Word. Use the Microsoft Word
print option.

e Open “Windows Explorer” and navigate to the directory containing this ICD.
Right click on the “CDM Message Protocol v2.4.doc” file and select the “Print”
option.

@j

CDM Message
Protocol v2.4.doc
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